Comparison of stress behaviour in thermal barrier coatings using FE analyses

Tobias Hansson      Kristoffer Skogsberg
Comparison of stress behaviour in thermal barrier coatings using FE analyses

Summary

The objective of this thesis project was to compare the stress behaviour in thermal barrier coatings (TBCs) with FE analyses in both 2D and 3D. The main focus was to analyse the vertical stresses in the topcoat (TC) and how they varied in relation to different thicknesses of the thermally grown oxide (TGO), spraying methods of the bondcoat (BC) and the topography of the BC.

For the 2D simulations six samples were used; three with BCs sprayed with high-velocity oxy-fuel spraying and three sprayed with atmospheric plasma spraying. The samples had been exposed to isothermal heat treatment at 1150 °C for 0, 100 and 200 hours. Five images of each sample were taken with a scanning electron microscope, resulting in a total of 30 images. FE simulations based on these 30 images were done simulating a cooling from 1100 °C to 100 °C.

The 3D simulations were based on surfaces created from coordinates measured with stripe projection technique on three samples consisting of only substrate and BC. Three domains of each sample had been measured and three CAD models based on randomly selected surfaces of each domain were made, resulting in 27 CAD models. The CAD models were used in the 3D FE simulations also simulating a cooling from 1100 °C to 100 °C.

The results showed that the 2D simulations corresponds to published assertions about a stress inversion after TGO growth and that cracking will propagate from one peak to another, presuming the roughness of the TGO can be expressed as a wave. No conclusions of differences between spraying methods of the BC could be drawn.

The stress inversion phenomenon was also found in the 3D simulations. By inspecting the TGO/TC-interface profile in different sections of a 3D model, difficulties in predicting the stress behaviour in a TBC with 2D were explained. No differences in stresses in relation to the BC roughness could be stated.
Preface

This thesis project was conducted at the Production Technology Centre (PTC) in Trollhättan, Sweden from mid-January 2012 until early April the same year. The work was mainly focused in developing proper methods for, and then performing 2D and 3D finite element simulations of thermal barrier coatings.

The 2D part was primarily performed by Tobias and the 3D part by Kristoffer, although all work was frequently discussed and most decisions and conclusions were drawn mutually. Additional work, e.g. writing the report and preparing the presentation were divided equally.

We would like to thank our advisor Mohit Kumar Gupta at PTC for continuous help and support throughout the entire project and for some literature suggestions which gave us substantial understanding about TBCs. We would also like to thank Prof. Per Nylén at PTC for valuable discussions and for giving us the opportunity to perform this project and Nicholas Curry at PTC for helping us with the SEM.

Last, but not least, we would like to express our appreciation to our advisor at the university, Asst. Prof. Kjell Niklasson, for his willingness to share his knowledge about ANSYS.

Trollhättan, April 2012

Tobias Hansson
Kristoffer Skogsberg

Unless otherwise stated, all figures, tables and graphs are made by the authors.
## Contents

Summary ................................................................................................................................. i  
Preface ................................................................................................................................... ii  
Symbols and glossary ........................................................................................................... v  
1 Introduction ......................................................................................................................... 1  
1.1 Company introduction ................................................................................................. 1  
1.2 Background .................................................................................................................. 2  
1.3 Objectives .................................................................................................................... 2  
1.4 Limitations and assumptions ....................................................................................... 3  
1.5 Overview of previous works ......................................................................................... 3  
2 Theory .................................................................................................................................. 4  
2.1 Thermal barrier coating systems ................................................................................. 4  
2.1.1 Topcoat .................................................................................................................... 5  
2.1.2 Thermally grown oxides ......................................................................................... 5  
2.1.3 Bondcoat ................................................................................................................ 5  
2.1.4 Substrate ................................................................................................................ 5  
2.1.5 Porosities and cracks .............................................................................................. 5  
2.1.6 Cracking ................................................................................................................ 6  
2.2 Thermal spraying .......................................................................................................... 8  
2.3 The FE software OOF .................................................................................................. 9  
3 Methodology ....................................................................................................................... 11  
4 2D microstructure analyses ............................................................................................... 12  
4.1 SEM images of microstructures .................................................................................. 12  
4.2 Image pre-processing .................................................................................................. 13  
4.3 Mesh generation in OOF ............................................................................................ 14  
4.4 FE analysis in ANSYS ................................................................................................. 16  
5 3D surface analyses ........................................................................................................... 19  
5.1 Coordinate file pre-processing .................................................................................. 20  
5.2 CAD model of a TBC system ...................................................................................... 20  
5.3 FE analysis in ANSYS ................................................................................................. 21  
6 Verification of the FE models ........................................................................................... 24  
6.1 2D FE models .............................................................................................................. 24  
6.1.1 Young's modulus .................................................................................................... 24  
6.1.2 Substrate height ..................................................................................................... 27  
6.1.3 Meshing procedure ............................................................................................... 28  
6.2 3D FE models .............................................................................................................. 28  
6.2.1 Mesh creation ........................................................................................................ 28  
6.2.2 Methods for creating surfaces .............................................................................. 30  
7 Results and discussion ....................................................................................................... 32  
7.1 2D microstructure simulations .................................................................................... 32  
7.2 3D surface simulations ............................................................................................... 34  
8 Conclusions and future work ............................................................................................ 37  
References ............................................................................................................................. 40
Appendices
A. SEM images
B. MATLAB algorithm
C. Coordinate file format
D. Point interpolation
E. 2D and 3D FE models with rigid blocks
F. Effective Young’s modulus values
G. Specifications and images of bondcoat surfaces
H. Comparison between different surface creation methods
## Symbols and glossary

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alumina</td>
<td>Aluminium oxide</td>
</tr>
<tr>
<td>ANSYS</td>
<td>FE software</td>
</tr>
<tr>
<td>APS</td>
<td>Thermal spraying technique (Atmospheric Plasma Spraying)</td>
</tr>
<tr>
<td>As-sprayed</td>
<td>State of thermal sprayed coatings before additional treatment</td>
</tr>
<tr>
<td>BC</td>
<td>Bondcoat</td>
</tr>
<tr>
<td>CAD</td>
<td>Computer Aided Design</td>
</tr>
<tr>
<td>FEA</td>
<td>Finite Element Analysis</td>
</tr>
<tr>
<td>HVOF</td>
<td>Thermal spraying technique (High-Velocity Oxy-Fuel)</td>
</tr>
<tr>
<td>IHT</td>
<td>Isothermal Heat Treatment</td>
</tr>
<tr>
<td>ImageJ</td>
<td>Image processing software</td>
</tr>
<tr>
<td>MATLAB</td>
<td>Programming software</td>
</tr>
<tr>
<td>NX</td>
<td>CAD software</td>
</tr>
<tr>
<td>OOF</td>
<td>FE software (Object Oriented Finite Elements)</td>
</tr>
<tr>
<td>PTC</td>
<td>Production Technology Centre</td>
</tr>
<tr>
<td>SEM</td>
<td>Scanning Electron Microscope</td>
</tr>
<tr>
<td>TBC</td>
<td>Thermal Barrier Coating</td>
</tr>
<tr>
<td>TC</td>
<td>Topcoat</td>
</tr>
<tr>
<td>TCF</td>
<td>Thermal Cycling Fatigue</td>
</tr>
<tr>
<td>TGO</td>
<td>Thermally Grown Oxides</td>
</tr>
<tr>
<td>YPSZ</td>
<td>Yttria Partially Stabilized Zirconia</td>
</tr>
</tbody>
</table>
1 Introduction

This thesis project was conducted at the Production Technology Centre (PTC) in Trollhättan, Sweden. The main purpose was to examine how the stresses in the bondcoat/topcoat-interface of a thermal barrier coating (TBC) are affected by the thickness of thermally grown oxides (TGO) and surface roughness of the bondcoat.

Thermal barrier coatings are today commonly used in gas turbines due to their ability to protect the coated metal/alloy against the high temperature environment [1-3]. A widely used material in the topcoat of TBCs is yttria partially stabilised zirconia (YPSZ), due to its low thermal conductivity and good mechanical properties. This enables an increased combustion temperature in gas turbines, and consequently higher efficiency [1]. A combustion chamber from a Rolls Royce Tay commercial engine with an applied thermal barrier coating is shown in Figure 1.

![Figure 1: A combustion chamber from a Rolls Royce Tay commercial engine with an applied thermal barrier coating.](image)

The bondcoat of a TBC is normally an alloy with a large amount of aluminium. When the TBC is exposed to thermal stress the aluminium in the bondcoat will react with oxygen, that has penetrated the topcoat through porosities, and form a layer of alumina along the bondcoat/topcoat-interface. The alumina is, compared to the other layers of the TBC, much stiffer. [3]

Due to differences in thermal expansion between the layers of the TBC system and the volumetric change caused by the growth of TGO, stresses in the TBC will increase. Eventually this will lead to spalling of the topcoat. [2, 4]

The field of interest in this thesis project is the vertical stresses in the topcoat since they are the cause of spalling. It is assumed that cracking starts in the topcoat (TC) near the TGO/TC-interface.


1.1 Company introduction

The Production Technology Centre (PTC) is the most modern laboratory in Sweden focusing on production technology. PTC is a collaboration between Innovatum Technology Park, University West, and industrial companies such as Volvo Aero. [5]

The areas of focus at PTC are [6]:

- Metal cutting
- Welding
- Coating
- Measurement and technology control
- Mechatronics in industrial applications
- Virtual Manufacturing

The close cooperation between researchers and developers at industrial companies makes the results available to the industry quickly [7].

1.2 Background

Recent research at PTC has shown that the lifetime for TBCs is longer when using atmospheric plasma sprayed (APS) bondcoats compared to bondcoats sprayed with the high-velocity oxy-fuel method (HVOF). This was discovered by testing the life of sprayed specimens of both methods in a thermal cycling furnace. The specimens were heated to 1100 °C for one hour and then cooled with air for 10 minutes. This was done in cycles until partial or complete spalling of the topcoat occurred. As previous research shows the opposite, this result was unexpected. [8, 9]

1.3 Objectives

The first objective with this thesis project was to investigate if the difference in life of the TBCs with APS and HVOF sprayed bondcoats (BC) could be explained based on the results from 2D FE analyses of the vertical stresses in the topcoat, with different TGO thicknesses. The mesh should be based on cross-sectional images of the microstructure, photographed with a scanning electron microscope (SEM).

The second objective was to examine and analyse the stress variations resulting from different surface roughnesses of the BCs. This was supposed to be done by performing 3D FE analyses with surfaces created from lists of coordinates from real specimens prepared in three different ways.
1.4 Limitations and assumptions

Six different specimens were provided for the 2D FE analyses, three with HVOF sprayed BCs and three with APS sprayed BCs. The specimens were at different aging stages: As-sprayed, heat-treated isothermally for 100 hours and heat-treated isothermally for 200 hours. Five SEM images per sample were taken to keep the number of simulations at a reasonable level for the time frame of the thesis project.

In the 2D FE analyses, the bondcoats were simplified as homogenous. This was done in order to reduce the calculation time since only the stresses in the topcoat were of interest.

All TGOs were considered to be alumina to reduce the number of parts and layers and thereby simplifying the models. In reality, different types of oxides can occur in the BC-TC interface in addition to alumina, e.g. chromium oxide and spinel [2].

Both the 2D and 3D FE analyses were focused on residual vertical stresses in the TC. The thickness of the TGO in the 3D FE analyses was estimated based on the SEM images taken for the 2D analyses.

As a prerequisite for the 3D FE analyses, three surfaces with different roughness were used, with three domains per surface.

For all provided samples considered in this thesis project the substrate material was Hastelloy X.

1.5 Overview of previous works

When considering previous work in the field of simulating TBC systems, studies have been performed focused on 2D theoretical models. These models are often simplified with a symmetric TGO shape of a sinusoidal curve, representing the usually irregular shape of a TGO in real TBC systems [3, 10]. A symmetric 2D model of the simplified TGO shape has been modelled by Niklasson at University West, Trollhättan, simulating a cooling of the TBC system [11].

The FE software OOF has in recent years been used to create meshes of microstructures in different studies. Gupta [4] used OOF to create a mesh based on the microstructure of the topcoat in a TBC to predict the thermal conductivity.

Prawoto et al. [12] used OOF to create meshes of microstructures and then combining the use of OOF with ANSYS to perform simulations.

These previous works were beneficial for this thesis project in terms of confirming models and applied methods.
2 Theory

This chapter explains TBC systems and the basics about the two thermal spraying methods HVOF and APS. An explanation to the FE software OOF is also presented. Several software applications have been used in this thesis project but OOF is the only one considered not to be commonly used and therefore needs further explanation.

2.1 Thermal barrier coating systems

To reach higher efficiency, which is a requirement in gas turbines, a high combustion temperature is necessary [1]. A high combustion temperature results in decreased fuel consumption and increased performance. The conflict is that the metals used melt at too high temperatures. A way to raise the combustion temperature without melting the metals is to apply a thermal barrier consisting of a ceramic layer [1]. The ceramic applied is more resistant to heat compared to the metals. A coating system of this kind is called a thermal barrier coating (TBC) [2].

A TBC system initially consists of three layers: a superalloy substrate, a metallic bondcoat and a ceramic topcoat. A fourth layer, thermally grown oxides mainly consisting of alumina, emerges in the BC-TC interface during high temperature operations [1]. A schematic representation of a TBC system and the functions and typical materials for the different layers are shown in Figure 2.

![Figure 2: Schematic representation of a TBC system in cross-section with materials and functions of the different layers.](image-url)
2.1.1 Topcoat
The components of a gas turbine experience tough thermal cycling involving quick heating and cooling. The purpose of the topcoat is to act as a thermal insulation and to improve durability for the components in the gas turbine environment [1, 13]. A material commonly used for this is the ceramic yttria partially stabilized zirconia (YPSZ). Pure zirconia undergoes a phase change at approximately 400 °C, which leads to volumetric expansion and induces stresses [14]. Therefore the adding of yttria is necessary. The YPSZ has the properties of low thermal conductivity, resistance to high temperatures, approximately 1400 °C, and good resistance against erosion [15]. The YPSZ topcoat microstructure is heterogeneous due to pores and cracks. These defects affect the final properties of the TC in terms of thermal conductivity and flexibility. [15]

2.1.2 Thermally grown oxides
The thermally grown oxides occur in the BC-TC interface due to oxidation of the bondcoat, which usually is enriched with aluminium [16]. The oxide is desired since it gives a protection for the substrate against the flow of oxygen and exhaust gases that pass through the topcoat [1]. However, the alumina has a low thermal expansion coefficient and a high stiffness compared to the other layers in the TBC system, which leads to increased stress levels during thermal cycling [16].

2.1.3 Bondcoat
The bondcoat (BC) behaves as a bonding layer between the topcoat (TC) and the substrate. Since the TC usually is a ceramic [15], it has low thermal expansion compared to the superalloy used in the substrate [3]. The BC levels out the difference in the thermal expansion between the TC and substrate [1]. Oxygen and exhaust gases penetrate the ceramic TC and the BC protects the substrate against oxidation and corrosion. Moreover it provides a good adhesion of the TC. The BC usually contains aluminium in order to generate a protective layer of alumina [1].

2.1.4 Substrate
A widely used material in gas turbine parts today is nickel-based superalloys [17]. For all samples considered in this thesis project the substrate material was Hastelloy X.

Hastelloy X is a nickel-based superalloy that is characterised by good oxidation resistance and high-temperature strength. It is commonly used due to good forming characteristics and weldability with different welding methods. [18]

2.1.5 Porosities and cracks
The microstructures of TBCs and the TCs in particular, are highly heterogeneous [19]. The formation of the microstructure affects the thermal and mechanical properties, and thereby the life, of the TBC [1].
There are different types of cavities appearing in the TC: pores, horizontal cracks and vertical cracks. The horizontal cracks improve the insulating ability of the coating. The vertical cracks, also known as segmentation cracks, increase the flexibility of the coating, but also the heat transfer to the substrate. The advantages and disadvantages of the different crack types are summarised in Table 1. [19]

<table>
<thead>
<tr>
<th>Crack type</th>
<th>Advantage</th>
<th>Disadvantage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Horizontal cracks</td>
<td>• Improve insulating ability</td>
<td>• Might cause spalling if they propagate</td>
</tr>
<tr>
<td>Vertical cracks</td>
<td>• Increase flexibility</td>
<td>• Increase the heat transfer to the substrate</td>
</tr>
</tbody>
</table>

2.1.6 Cracking

At the interface between the BC and the TC a TGO layer consisting of alumina is grown due to the oxidation of aluminium in the BC (Figure 3).

Since there is a significant difference between these layers’ thermal expansion, the thermal cycling which the turbine components are exposed to leads to stresses. Furthermore, the growth of the TGO leads to volumetric expansion in the interface of the BC and TC. This in turn leads to increased stresses. These stresses will eventually lead to a fracture in either the TC or the TGO. [4, 16]
The ceramic TC is brittle, which makes it vulnerable to tensile stresses. According to Vaßen et al. [3], the vertical stresses in the TC appear as tensile stresses at the peaks and compressive stresses in the slopes and valleys for an as-sprayed coating. After TGO growth the stresses are inversed, resulting in tensile stresses at the valleys and slopes, see Figure 4.

![Figure 4: Schematic illustrations of the stresses in the topcoat at a) the as-sprayed condition and b) after TGO growth.](image)

The initiating cracking usually occurs in the interface between the TGO and the TC. The cracks then tend to evolve from peak to peak, presuming the surface roughness of the bondcoat, and thereby the TGO, can be expressed as a sinusoidal wave [9, 20]. The vertical stresses in a simulation with the TGO shape expressed as a uniformly thick sinusoidal wave made by Niklasson [11] confirms this behaviour, see Figure 5.

![Figure 5: 2D simulation of a uniformly thick sinusoidal wave illustrating a) the vertical stresses in the topcoat before TGO growth, b) the vertical stresses in the topcoat after TGO growth, c) predicted crack propagation and d) spalling of the topcoat.](image)

As Figure 5a shows, the tensile vertical stresses appear on the peaks, where the cracking initiates, at the as-sprayed condition. The cracks propagate along the slopes until they reach the area with compressive vertical stresses. In Figure 5b the TGO has grown and the stress inversion has taken place. The tensile vertical stresses now appear on the slopes and evolve towards the middle, forming a bridge-like overlap
where the cracks continue to propagate. As seen in Figure 5c the cracks have grown together causing the topcoat to spall-off (Figure 5d).

In Figure 6 an example of a real TBC specimen after spalling of the topcoat is shown.

![Cross-section of a TBC with a detached topcoat](image)

Figure 6: Scanning electron microscope (SEM) image showing a cross-section of a TBC with a detached topcoat.

### 2.2 Thermal spraying

The bondcoat and topcoat of a TBC system are applied using thermal spraying [21]. Thermal spraying is a coating process where a protective coating is formed by spraying melted or heated materials, usually in the form of a powder, onto a surface. Droplets of the melted or heated materials are shot with a jet against a substrate where they flatten and solidify quickly. [22]

As long as a material does not decompose near its melting temperature it can be applied using thermal spraying, giving a large variety of materials to use [23].

The thermal spraying techniques relevant to this thesis project are high-velocity oxy-fuel (HVOF) spraying and atmospheric plasma spraying (APS). Using APS, the particles are heated, melted and accelerated in the plasma. The plasma is generated using a mixture of gas which is fed between an anode and a cathode. The voltage between these is very high, resulting in plasma that reaches temperatures exceeding 25000 °C [23]. Because of the extreme temperature, plasma spraying is a suitable method for spraying ceramic materials [22].

In the HVOF method a mixture of gaseous or liquid fuel and oxygen is ignited in a combustion chamber. The ignited fuel travels through a nozzle where powder is fed and accelerated towards the substrate at high speeds, up to 1000 m/s. The high speed of the powder results in an extremely dense coating with very high adhesion. [22]
2.3 The FE software OOF

The possibility to determine a material’s macroscopic properties based on its microstructure is of great importance to material science. In cases where the spatial geometry is too complex to be used in analytical models, finite element modelling is a beneficial supplement.

Langer et al. have created an image-based finite element software called OOF [24-26]. OOF gives the possibility to create finite element meshes based upon the pixel colours of an image. This means that a mesh that adapts to the boundaries of different layers consisting of different materials, pores or cracks can be created.

An initial step in OOF is to create pixel groups based on colours in an image. Different materials can then be assigned to the pixel groups. Images generated with an SEM are usually represented in grayscale. Even though the current version of the OOF software, OOF2, offers several tools for creating pixel groups of a grayscale image, it is common to modify the image before using it in OOF [4]. An example of this is to convert the image into binary format by thresholding to reduce the number of hues, thus making it more suitable for an automatic and repetitive method, see Figure 7.

![Figure 7: A small portion of a microstructure image from an SEM in a) the original grayscale and b) binary format.](image)

Materials can then be defined for the pixel groups and a mesh that adapts to the material boundaries can be created.

Before creating a mesh in OOF a skeleton is made. The skeleton is a grid that adapts to all pixel group boundaries in the image. The mesh is then generated based on the skeleton, but only for pixel groups having materials assigned.

There are several skeleton modifying options in OOF, many dependent on the two types of “energies” of the elements; shape energy and homogeneity energy [24]. The total energy of an element is calculated with the following equation:

\[
E = aE_{\text{hom}} + (1 - a)E_{\text{shape}}
\]  
(Eq. 1)

where

\[
E_{\text{hom}}\text{ is the definition of the homogeneity energy}
\]
$E_{\text{shape}}$ is the definition of the shape energy

$\alpha$ is an adjustable parameter between 0 and 1

A high value of $\alpha$ is used when the priority is the homogeneity of elements, i.e. it is more important that the element nodes match the image boundaries rather than keeping a good shape [24].

An example of a skeleton modification process is shown in Figure 8.

![Figure 8: A skeleton modification process in the FE software OOF based on the image in Figure 7b.](image)

Figure 8a shows an initial skeleton, without any consideration to the image boundaries. Figure 8b shows the skeleton after a number of Anneal iterations have been performed. The Anneal routine moves nodes randomly and accepts moves according to a given criterion [24]. In Figure 8c the Refine method has been used, which splits elements into smaller pieces to make the skeleton correspond better to the boundaries [24]. In Figure 8d and Figure 8e several additional skeleton modifying steps, e.g. Rationalize, have been used in order to further optimise the skeleton. The Rationalize option corrects badly shaped elements by modifying them and adjacent elements or by removing them completely [24].

During the skeleton creation process, OOF displays a homogeneity index showing the average homogeneity level of all elements. This value should increase during the process, as the skeleton gets finer and more adapted to the boundaries. If the index reaches 1, all elements are 100 % homogenous [27]

Meshes created in OOF can be saved in different file formats, which enable the use of OOF meshes in other FE software applications. This is advantageous when the use of FE software applications with more calculation and simulation options than OOF, such as ANSYS, is required.
3 Methodology

The thesis project consisted of two main parts, 2D and 3D FE analyses. This chapter describes the basic line of action taken for the two parts. Specific settings and boundary conditions of the FE models are explained in chapter 4 and 5.

In the beginning of the thesis project a literature study aiming to give an understanding of the software OOF2 and MATLAB was performed. While studying the programs theoretically, practical tests were performed. Information of the fundamentals of thermal spraying and the structure of TBC systems were collected all through the project. Reports and articles were gathered from different sources, such as the university library and electronic databases, to attain a wide field of information and to ensure that the information was accurate as well as consistent. The competences of the company were also used to gather knowledge in the area of thermal spraying and TBC systems. An introduction of how to operate the scanning electron microscope was given so that the process could be performed independently.

For both the 2D and 3D analyses, methods for proper handling and conversion of files between different software applications were developed. Detailed manuals considering all steps included in the processes were made to facilitate future work for other employees at the company.

As a first step of the 2D FE analyses, cross-sectional images of six TBC specimens, three per spraying method, were taken with a scanning electron microscope (SEM). Five images per specimen, i.e. a total of 30 images, were taken. The layers of the TBC system in these images were then made homogenous and re-coloured using Adobe Photoshop, ImageJ and Microsoft Paint. This was done in order to simplify the models prior to generate meshes in OOF. The generated meshes were exported to ANSYS where a static structural analysis was performed for each mesh.

The 3D FE simulations began with preparing text files consisting of coordinates of the surface topography of three different bondcoats, measured with stripe projection technique. Each bondcoat was prepared with different surface treatment. For each bondcoat, three domains had been measured, resulting in a total of nine domains. The samples had no ceramic topcoat sprayed at the time of the measuring.

By using the software MATLAB, three random segments of each domain were generated and adapted to a compatible format for creating surfaces in the CAD software NX. The surfaces were then used in NX to create models that represented the four layers present in thermal barrier coating systems. A total of 27 CAD models were made and then transferred to ANSYS which was used as mesh generator and simulation software.

Comparisons between the results of the 2D and the 3D simulations were performed to search for similarities and differences as well as comparing them with the results of the simplified symmetric 2D FE simulation made by Niklasson [11].
4 2D microstructure analyses

All six specimens used in the 2D analyses had BCs sprayed with a Sulzer Metco AMDRY 386 powder. The plasma sprayed BCs were sprayed with a Sulzer Metco Triplex Pro gun and the HVOF sprayed BCs with a DJ2600 gun. The ceramic topcoat was applied using a Sulzer Metco F4 gun for all specimens. All specimens had been sprayed by personnel at PTC before this thesis project started.

The specimens used in this thesis project were part of a larger series. They had all been exposed to an isothermal heat treatment (IHT) at 1150 °C in a furnace under a standard atmospheric pressure for 5, 25, 50, 100 and 200 hours. In addition to the heat treated specimens, the series also included as-sprayed specimens.

The specimens selected for this thesis project were the as-sprayed specimens and those exposed to 100 and 200 hours to get a large disparity in TGO thickness.

4.1 SEM images of microstructures

Images of the cross-sectional microstructures of pre-treated TBC specimens were produced using a scanning electron microscope (SEM) in composition mode [28]. The purpose of using composition mode was to acquire images with different colour tones corresponding to different materials [29]. The SEM that was used was a Hitachi Analytical Tabletop Microscope TM-3000 [30].

The images were taken with 1000x magnification to capture approximately one wavelength of the TGO profile. The resolution of the images was chosen to highest option available, 1280x960 pixels, in order to get as detailed images as possible. The acceleration voltage was set to 15 kV. To avoid noise in the images caused by surrounding air, the SEM operates in vacuum.

In order to get equivalent results for all images, automatic settings for focus, brightness and contrast were used. An example of the images taken with the SEM is shown in Figure 9. All SEM images are shown in Appendix A.
Figure 9: An image of the cross-sectional microstructure of a TBC with an HVOF sprayed bondcoat exposed to 100 hours of IHT taken with an SEM.

In order to get a correct representation of a specimen when using the SEM, the materials in the specimen need to be electrically conductive [31]. Since the YPSZ has low electrical conductivity, the specimens were prepared with a thin gold coating called a sputter coating, before mounting them in the SEM. The sputter coatings were applied using a Cressington Sputter Coater 108auto [32].

4.2 Image pre-processing

The images produced with SEM were, as seen above in Figure 9, in grayscale, with a large amount of different hues. The mesh generation in OOF is based on the colours in the image. Consequently, the images had to be pre-processed before import to acquire a reduction of the amount of colours and make the procedure more manageable. This was done by first making the images binary using threshold in the software Adobe Photoshop. The same threshold level was set for all images. To simplify the models, all porosities were deleted making all layers completely homogenous, due to cumbersome simulations and results that were impossible to interpret. This simplification was compensated for by changing the material properties.

The different material layers were re-coloured and an additional layer representing the substrate was added. A cropped illustration of a re-coloured image is shown in Figure 10.
4.3 Mesh generation in OOF

The images with re-coloured material layers were imported into the FE software OOF one by one. The command Create Microstructure Using Image was used. OOF offers two ways to determine the size of an image: pixel size and physical size. If no physical size is specified it is considered to be the same as the pixel size. To avoid getting meshes that were 1280x9300 mm when exported to ANSYS, the physical sizes were specified to 0.21x1.52 mm.

Four pixel groups were created based on colours, one for each material. As a default, the names of the pixel groups correspond to their hex colour code. They were re-named to Substrate, BC, TGO, and TBC to make the model more manageable. Also, the same colours were used in every image to enable an automatic method.

Materials were created and assigned to all pixel groups except for the substrate. Since the shape of the substrate layer is a simple rectangle, the substrate was later added into ANSYS as a CAD-model to enable a mesh with large, straight elements on that part.
No material properties were added in OOF, since the properties are not stored when the mesh is exported [27]. However, the output file contains information that indicates where the materials should be defined and creates element groups for every material. The material properties were later added in ANSYS.

An automatic method was used to create a skeleton based on the image with 20 pixels as the maximum element size, which was considered to be small enough to get accurate results and large enough to avoid unmanageable models. The minimum element size was set to 6 pixels to enable an accurate expression of the complex geometry closest to the interfaces between layers. The minimum acceptable homogeneity was given a value of 1 to achieve as homogeneous elements as possible. Even though the homogeneity index was set to 1, OOF does not refine elements that have reached the assigned minimum element size, even if the homogeneity level of those elements are less than 1 [27].

The skeleton is a grid adapted to the pixel group boundaries in the image and those elements that have associated materials work as foundation for the mesh generation. A mesh with second order elements was generated (Figure 11), since such elements can express results more accurate compared with first order elements due to more nodes. The mesh was then exported in an ABAQUS format [33] to make it compatible with ANSYS for further work.

![Figure 11: A mesh generated in OOF with second order elements based on an SEM image from the sample with an HVOF sprayed bondcoat exposed to 200 hours of IHT.](image)

All process steps done in OOF have a text representation and are saved in a log file [26] written in Python-code [34]. This file was utilized to make the mesh generation automated for the following microstructure images. Since the same colours were used
in every picture, the only things changed in the log file were the filename of the image and the name of the ABAQUS mesh to be saved. This was done to facilitate the process and to reduce possible human errors.

### 4.4 FE analysis in ANSYS

The meshes created in OOF were exported to ANSYS in the ABAQUS format one by one. A 2D CAD model representing the substrate and a rigid block made in NX was imported and merged with the geometry associated with the mesh from OOF, see Figure 12.

![Figure 12: The model of a TBC system with the rigid block attached to the right edge acting as a support.](image)

The substrate and rigid block was meshed with an element size of 35 µm to get evenly distributed elements along the width which corresponded to 420 µm. This element size was considered to be small enough for these parts, since they were not in the area of interest. Materials for the substrate and rigid block were added to the materials already created in OOF and properties were assigned according to Table 2.

<table>
<thead>
<tr>
<th>Component</th>
<th>Coefficient of thermal expansion [1/°C]</th>
<th>Young’s modulus [MPa]</th>
<th>Poisson’s ratio</th>
</tr>
</thead>
<tbody>
<tr>
<td>TC (YPSZ)</td>
<td>1.07E-05</td>
<td>20 000</td>
<td>0.33</td>
</tr>
<tr>
<td>TGO (Al₂O₃)</td>
<td>8.00E-06</td>
<td>360 000</td>
<td>0.22</td>
</tr>
<tr>
<td>BC (NiCoCrAlY)</td>
<td>1.75E-05</td>
<td>70 000</td>
<td>0.43</td>
</tr>
<tr>
<td>Substrate (Hastelloy X)</td>
<td>1.60E-05</td>
<td>191 000</td>
<td>0.30</td>
</tr>
</tbody>
</table>

The material data were collected from Vaßen et al. [3], except for the coefficient of thermal expansion, since it was stated by Vaßen et al. that the TGO had the largest value. This was assumed to be inaccurate since the oxide often is referred to as the layer with lowest coefficient of thermal expansion [10, 13, 35]. The values stated by
Vaßen et al. [3] for the coefficient of thermal expansion were therefore exchanged to values from an earlier article from Vaßen et al. [13].

The rigid block was added to function as a support to force all layers in the TBC system to contract equally in horizontal direction, despite different coefficients of thermal expansion. The rigid block was given a Young’s modulus of $10^9$ MPa and a coefficient of thermal expansion of $0.1/°C$.

Static Structural was chosen as the analysis type and a dummy thickness of 1 mm was assigned to all parts. The Environmental Temperature in ANSYS, i.e. the ambient temperature, was set to 1100 °C to achieve a stress free initial state. The thermal strain is calculated in ANSYS with the following equation:

$$\varepsilon_{\text{thermal}} = \alpha(T_{\text{final}} - T_{\text{initial}})$$  \hspace{1cm} (Eq. 2)

where

$\varepsilon_{\text{thermal}}$ is the strain caused by thermal expansion

$\alpha$ is the coefficient of thermal expansion [1/°C]

$T_{\text{final}}$ is the input temperature [°C]

$T_{\text{initial}}$ is the ambient temperature [°C]

Before adding any input temperature, i.e. a Thermal Condition, both temperatures in Eq. 2 will be equal, resulting in a strain free initial state. Therefore, no stresses appear, in accordance with Vaßen et al. [3, 13] who state that the stresses in the TBC can be considered as totally relaxed at high temperatures. This was done since the focus in this thesis project was residual vertical stresses in the topcoat after cooling.

All contacts between different TBC parts were set to the contact type Bonded, which behaves as a glued contact, i.e. no separation and no sliding. Between each TBC part and the rigid block contacts of contact type No Separation were added. As the name indicates this contact type does not allow separation of faces or edges, but enables frictionless sliding, which implies that the right side of the TBC system could be kept perfectly vertical. [36]

At the left and bottom edges of the model Frictionless Supports were added. At the right edge, on the rigid block, a Remote Displacement support with fixed rotation in Z-direction was added, see Figure 13. This enabled the rigid block to move horizontally thus allowing thermal expansion of the TBC model.

A Thermal Condition of 100 °C was applied on all faces of the model, in order to simulate a cooling from the operational temperature of 1100 °C to 100 °C in thermal cycling fatigue (TCF) tests.

The only stress calculation considered was the normal stress in Y-direction, i.e. the vertical stress appearing in the topcoat.
Figure 13: Three Frictionless Supports and one Remote Displacement added to the 2D-model in ANSYS.
5 3D surface analyses

3D simulations in ANSYS were performed to see if the models could explain how different bondcoat surface roughnesses affect the vertical stresses in the topcoat. The 3D FE simulations represent a section from a thermal barrier coating system in TCF tests experiencing cooling from operational temperature of 1100 °C to 100 °C.

The bondcoats used on the examined samples were sprayed with a Sulzer Metco F4 atmospheric plasma spraying (APS) gun, using a Sulzer Metco AMDRY 386 powder. All samples had been sprayed at PTC before this thesis project started.

The first stage in the procedure was to adapt coordinate files to NX. The coordinate files were received from Toponova AB, located in Halmstad, Sweden [37]. The measured samples were 2.46x1.88 mm, see Table 3.

<table>
<thead>
<tr>
<th>Sample</th>
<th>Domain</th>
<th>Preparation method</th>
<th>Surface roughness, $S_a$ [µm]</th>
<th>Extreme peak height, $S_{xp}$ [µm]</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>A₁</td>
<td>✓</td>
<td>13.5</td>
<td>85.8</td>
</tr>
<tr>
<td></td>
<td>A₂</td>
<td>✓</td>
<td>13.0</td>
<td>78.6</td>
</tr>
<tr>
<td></td>
<td>A₃</td>
<td>✓</td>
<td>12.7</td>
<td>77.8</td>
</tr>
<tr>
<td>B</td>
<td>B₁</td>
<td>✓</td>
<td>8.87</td>
<td>52.0</td>
</tr>
<tr>
<td></td>
<td>B₂</td>
<td>✓</td>
<td>8.86</td>
<td>49.3</td>
</tr>
<tr>
<td></td>
<td>B₃</td>
<td>✓</td>
<td>7.45</td>
<td>55.0</td>
</tr>
<tr>
<td>C</td>
<td>C₁</td>
<td>✓</td>
<td>3.49</td>
<td>24.4</td>
</tr>
<tr>
<td></td>
<td>C₂</td>
<td>✓</td>
<td>2.48</td>
<td>17.8</td>
</tr>
<tr>
<td></td>
<td>C₃</td>
<td>✓</td>
<td>2.81</td>
<td>18.6</td>
</tr>
</tbody>
</table>

The stripe projection technique consists of an LCD projector that projects lines on the sample, a line scan camera that interprets the projected lines, and a device to move the sample and the camera [38].

Three different samples had been prepared with different types of surface treatments, in order to acquire different surface roughnesses, see Table 4.
As Table 4 illustrates, three measured domains were provided for every sample, which resulted in a total of nine domains with different surface roughness.

5.1 Coordinate file pre-processing

The usage of MATLAB turned out to be necessary since the files received from Toponova AB were not compatible with NX. A manual correction would be too time consuming since the files reached sizes exceeding 80 MB with 2 million points expressed with X-, Y- and Z-coordinates.

The total size of the measured area had to be decreased to reduce simulation time in ANSYS as well as load time in NX. In order to represent at least one wavelength of the surface roughness profile, the program code generated a surface of 50x50 µm randomly, in accordance with the theoretical model used by Vaßen et al. [3].

The algorithm of the code programmed in MATLAB (Appendix B) is to receive and read the coordinate file and at a randomly picked X-coordinate insert a new row and write row numbers each time the X-coordinate corresponds to that value, see Appendix C. This format is necessary when inserting surfaces using the feature Through Points in NX [39].

Finally, the program code created a new file consisting of the decreased number of coordinates. In total three coordinate files of each domain were generated to reach representative cluster samplings. A total of 27 files were generated.

5.2 CAD model of a TBC system

To recreate the measured surface structure received from Toponova the coordinate files modified with MATLAB were read into NX. The insert option chosen to represent the surfaces was Through Points. With this option the created surface interpolates each point and therefore represents the real surface [40], see Appendix D.

This surface was used to represent the thermally grown oxide (TGO), the top face of the bondcoat (BC) and the bottom face of the topcoat (TC). The TGO layer was made by copying and vertically translating the created surface 10 µm and then using these surfaces as trim boundaries for an extruded body. This thickness of the TGO was estimated out of microstructure images taken for the 2D FE simulations of the samples exposed to 100 hours of isothermal heat treatment (Appendix A).

To enable an optimisation of the mesh and reduce simulation time in ANSYS, the TC and the BC were divided into two layers each. This was done to enable meshing with smaller elements at the layers adjacent to the TGO where the geometries are complex and the stress behaviour is of interest. Using the same trim boundaries as for the TGO, the bottom of the TC and the top of the BC were created. The substrate was then extruded at the bottom of the BC. In total there were six modelled layers repre-
senting the four materials in a TBC system. The TGO and its adjacent layers in a model from sample A are displayed in Figure 14.

In addition to the six layers representing the TBC system, two blocks were extruded along two sides to act as supports to enable the boundary surfaces to deform along a straight line in ANSYS, see Appendix E.

To get a close to realistic thickness relation between layers, the thickness of the topcoat was set to 0.4 mm and the bondcoat to 0.15 mm based on the SEM images taken for the 2D simulations. The actual substrate thickness in a TBC system is dominant. Therefore the substrate thickness in the models was set to 1 mm.

### 5.3 FE analysis in ANSYS

The geometry modelled in NX was imported to ANSYS after which each of the materials was specified. The same material properties as for the 2D FE analyses were used and *Static Structural* was chosen as the analysis type.

Meshes were created of each layer and the mesh density was concentrated at the TGO and the surrounding areas of the TC and BC, see Figure 15. On these parts tetrahedral elements were used. At the TGO the element size was set to represent the surface properly. For the cluster samplings from the untreated surface, sample A, an element size of 1 µm was needed. At the TC’s lower part an element size increasing from 1 µm to 5 µm was applied.

Since the stress distribution in the TC was investigated, the upper part of the BC was considered less important. The mesh size specified was therefore larger than for the other two parts with complex geometry, in order to decrease the number of nodes,
but small enough to still represent the surface profile. An element size increasing from 2 µm to 5 µm was used.

The specified element size needed to be adapted depending on which domain chosen due to the maximum number of nodes permitted. Figure 15 shows an illustration of the mesh distribution for a grit blasted model (domain B₁).

![Figure 15: Cropped image illustrating the different element sizes of the mesh applied to a model of domain B₁.](image)

The substrate and the additional parts corresponding to the upper TC, lower BC and the two rigid blocks were assigned a coarse hexahedral element size of 25 µm to reduce the amount of nodes and thereby the calculation time.

When the mesh had been applied the boundary conditions were added to the model, see Figure 16.

![Figure 16: Top view image of a 3D FE simulation model explaining the supports used. A and B are Frictionless Supports, C and D Remote Displacement supports.](image)
On two of the TBC systems surfaces, A and B, Frictionless Supports were applied to simulate a vertical movement, but still keeping the model straight and fixed in two planes. Remote Displacement supports were applied to the rigid blocks, C and D, fixed in one rotation each to enable volumetric reduction, but still prevent rotational movement. The combination of these two conditions was enabled by changing the contact types between the TBC system and the two blocks to No Separation. At the bottom faces of the model Frictionless Supports were applied.

The Static Structural simulation was performed using the same thermal parameters as the 2D simulations, with an ambient temperature of 1100 °C and a Thermal Condition of 100 °C applied on all parts.

The vertical stresses in the topcoat were compared for all simulations to search for similarities and differences. Comparisons with the 2D FE simulations were done as well.
6 Verification of the FE models

Various simplifications were made to the FE models in this thesis project to simplify the handling of certain files and to avoid time consuming simulations. In some cases simplifications had to be done to allow simulations at all, due to node limits of the software licences used.

One simplification made was that the models were homogenous, unlike the actual TBCs where especially the topcoat (TC) is heterogeneous including cracks and pores. This simplification leads to that stresses can be generated throughout the model unrestrained. The actual case would turn out different since cracks and pores would prevent or affect the stress propagation. The simplification however makes it easier to understand the idea of the stress behaviour in the TC, since the porosities cause too much stress concentrations, i.e. aggravating the interpretation of the results.

6.1 2D FE models

The simplification of making the TC homogenous would of course affect values of several material properties. To compensate for this, it was decided to make calculations of the effective values for these properties, starting with the horizontal Young's modulus. Due to the inconclusive results, no calculations of effective values of other material properties were made.

Further simplifications made in the 2D FE simulations were the reduced height of the substrate compared to the actual specimens and the exclusion of substrate and rigid block during the meshing procedure in OOF.

6.1.1 Young’s modulus

The original SEM images were cropped to 1280x500 pixels, equivalent to 210x83 µm, comprising solely the TCs. The images were made binary using thresholding in ImageJ [41]. The same procedure as for the complete TBC system models was used in OOF to create the meshes with the same skeleton settings. It was noticed that the smallest value for physical size possible to set in OOF was 0.1 mm. Therefore the physical sizes of the images were set to be 1000 times larger, i.e. 210x83 mm since it would not affect the results in this case. As a reference, hand calculations of the elongation of a homogenous block was made, see Figure 17.
Comparison of stress behaviour in thermal barrier coatings using FE analyses

Figure 17: The homogenous block used in the hand calculations of horizontal Young’s modulus. \( H \) represents the height, \( L \) the length, \( F \) the applied force and \( \Delta L \) the elongation.

The Young’s modulus for the YPSZ bulk material without porosities was set to 200 GPa \([42, 43]\), the thickness to 1 mm and the force to 100 kN. The elongation was calculated in accordance with Bodelind \textit{et al.} \([44]\), with the following equation:

\[
E = \frac{\sigma}{\varepsilon} = \frac{F/A}{\Delta L/L} = \frac{F/(H \times t)}{\Delta L/L} \rightarrow \Delta L = \frac{L \left( \frac{F}{(H \times t)} \right)}{E} \quad \text{(Eq. 3)}
\]

where

- \( E \) is the Young’s modulus [MPa]
- \( \sigma \) is the tensile stress [MPa]
- \( \varepsilon \) is the tensile strain
- \( A \) is the cross-sectional area \([\text{mm}^2]\)
- \( t \) is the thickness [mm]

This calculation gave an elongation of 1.28 mm.

The meshes generated in OOF where imported into ANSYS one by one where \textit{Static Structural} analyses were performed. The parts representing pores and cracks were suppressed, see Figure 18.

Figure 18: One of the meshes of the TCs used in the effective Young’s modulus simulations. The parts representing pores and cracks have been supressed.
A Displacement Support was applied on the left edge fixed in X-direction and another Displacement Support on the right edge with a displacement of 1.28 mm in X-direction. The reaction force was thereafter deduced. This force was used to calculate the effective Young’s modulus. This was done for all 30 images, and the average value per specimen was calculated, see Figure 19.

![Figure 19: The average effective Young's modulus per sample. The error bars represent two standard deviations (2σ).](image)

The standard deviations were calculated in accordance with Körner [45], with the following equation:

\[
\sigma = \sqrt{\frac{\sum(X^2) - (\sum X)^2}{n}}
\]  \hspace{1cm} (Eq. 4)

where

- \( \sigma \) is the standard deviation of the cluster sampling
- \( X \) is an individual measurement
- \( n \) is the number of objects in the cluster sampling

The spread was assumed to follow a normal distribution and the margin of error was calculated as twice the standard deviation (2\( \sigma \)) to achieve a confidence interval of 95%.

As seen in Figure 19, the standard deviation ranges overlap for all samples. The ranges are also wide compared to the average of each specimen. This might be because of the small amount of images per specimen. Errors in the meshes can also be a cause to the
wide range, since some meshes had cracks long enough to cut out big chunks of the YPSZ (top left corner in Figure 18). There is also a reason to believe that the Young’s modulus would increase rather than decrease after heat treatment due to sintering of the ceramic topcoat [3, 20, 35].

These facts made it difficult to select representative values and to believe that the Young’s modulus in fact differed between samples. Because of this, the Young’s modulus was chosen to 20 GPa for all samples, in accordance to Vaßen [3]. Due to this conclusion, no simulations for other material properties were made and already published data were used for these as well [3].

Calculated values of the effective Young’s modulus for all images are listed in Appendix F.

6.1.2 Substrate height

The substrate height of the 2D models was chosen to 1 mm to improve the manageability of the images. In reality, the substrate height was 3 mm for the considered specimens, but using this value would give image heights exceeding 20000 pixels. To investigate the effect of the height reduction, one simulation of the specimen with a HVOF sprayed bondcoat exposed to 100 hours of isothermal heat treatment (IHT) was made with 3 mm substrate height. The vertical stress behaviour was then compared to the same specimen with 1 mm substrate, see Figure 20.

![Figure 20: Vertical stress behaviour comparison between the specimen with HVOF sprayed bondcoat exposed to 100 hours of IHT with a) 1 mm substrate height and b) 3 mm substrate height.](image)

As Figure 20 shows, the vertical stress behaviour appears to be virtually identical for both simulations. The differences between the simulations’ maximum and minimum (tensile and compressive) vertical stresses were less than one percent and therefore deemed negligible. This comparison was considered to be enough to conclude that the substrate height was of less significance to the vertical stress levels and behaviour in the topcoat.
6.1.3 Meshing procedure
Concerning the choice of excluding the substrate and rigid block in OOF when creating the mesh and instead importing those parts separately, a comparison between the number of nodes and elements was made. When meshing all parts in OOF, the maximum element size was chosen to 20 pixels, the minimum to 6 pixels and the homogeneity index to 1. When excluding the substrate and rigid block from OOF the same settings were used for the remaining parts in OOF and the block and substrate were meshed with an element size of 35 µm in ANSYS.

The number of nodes and elements in the meshes of the two cases are summarised in Table 5.

<table>
<thead>
<tr>
<th>Case</th>
<th>Meshing procedure</th>
<th>Mesh specifications in ANSYS</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Nodes</td>
</tr>
<tr>
<td>1</td>
<td>Including substrate and block in OOF</td>
<td>334405</td>
</tr>
<tr>
<td>2</td>
<td>Excluding substrate and block in OOF</td>
<td>47846</td>
</tr>
<tr>
<td>Difference</td>
<td></td>
<td>286559</td>
</tr>
</tbody>
</table>

As seen in Table 5, the difference between the two cases is significant. One way of decreasing this difference is to increase the element sizes chosen in OOF. However, the minimum element size could not be increased due to the complex geometry of the TGO, nor the maximum element size without impairing the area of interest in the TC. The FE code also had a top limit of 256000 nodes, which made case 1 unsolvable.

6.2 3D FE models
Concerning the bondcoat (BC), the microstructure images taken for the 2D FE simulations of the samples exposed to 100 hours of isothermal heat treatment show that the BCs have sintered enough to be assumed homogenous. Therefore the material properties of a homogeneous BC were assumed applicable. Regarding the TC the same conclusions as for the 2D FE simulations were taken regarding homogeneity.

One concern of the 3D models was the mesh creation due to the differences in the surface roughness of the domains and thus investigated further.

6.2.1 Mesh creation
Due to the diversities in the models, difficulties applying the preferred mesh method consisting of second order hexahedron elements were a fact. The models from the untreated sample could not be expressed in hexahedral elements due to the extreme topography. Second order tetrahedral elements could be applied within the limitation
of nodes and express the surface profile. However, the tetrahedrons include 10 nodes compared to 20 nodes for the hexahedrons, see Figure 21.

![Figure 21: Illustration of a) second order hexahedral elements and b) second order tetrahedral elements.](image1)

Each node relates to the stress calculations, and depending on how many, and which order the elements have, the accuracy of the result is affected. A test with two simulations using models from domain \( C_1 \) and \( C_2 \) was made to compare second order elements. These simulations showed that using tetrahedrons instead of hexahedrons would not affect the results remarkably for this test, see Figure 22.

![Figure 22: Illustration of a model from domain \( C_1 \) with a) hexahedral elements and b) tetrahedral elements with red fields illustrating tensile vertical stress, and blue fields compressive vertical stress.](image2)

The values of the maximum and minimum Z-axis stresses, i.e. the vertical stresses, turned out to differ between 0 and 9.5 percentages, see Table 6.

Table 6: Difference in stresses between hexahedral and tetrahedral elements applied on models of the two domains \( C_1 \) and \( C_2 \).  

<table>
<thead>
<tr>
<th>Element type</th>
<th>Domain ( C_1 )</th>
<th>Domain ( C_2 )</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Maximum</td>
<td>Minimum</td>
</tr>
<tr>
<td>Hexahedron, 20 nodes</td>
<td>148</td>
<td>-166</td>
</tr>
<tr>
<td>Tetrahedron, 10 nodes</td>
<td>134</td>
<td>-163</td>
</tr>
<tr>
<td>Difference (%)</td>
<td>9.5</td>
<td>1.8</td>
</tr>
</tbody>
</table>
When generating the tetrahedrons on the same surface as the hexahedrons the elements express the surface profile differently. Due to e.g. sharp edges that can occur along the model boundaries, various stress concentration values may differ depending on the elements present. The use of tetrahedrons can therefore be assumed to be as accurate as hexahedrons using this simple comparison.

The matter of interest was to compare the simulations with each other and not explain the real stresses in actual TBCs. Therefore the same elements in all simulations were used.

6.2.2 Methods for creating surfaces

There are several ways of creating a surface in NX using a file of coordinates. To determine which method that was most suitable for expressing the real bondcoat surfaces, a comparison between the methods Through Points, From Poles and From Point Cloud was made.

Through Points creates a surface that passes through each specified point [40]. From Poles uses the specified points as vertices, and approximates a surface depending on adjustable degrees for rows and columns [40]. From Point Cloud approximates a large “cloud” of points. This method can create a surface from a large amount of points with a small amount of interaction [46].

A small sample, 20x20 coordinates from domain B₁, was used in the comparison between the three methods, see Figure 23.

![Figure 23: A 20x20 coordinate surface from domain B₁ created with a) Through Points b) From Poles and c) From Point Cloud.](image)

Assuming that the measured coordinates from Toponova are a correct representation of the real surfaces (Appendix G), Through Points proved to be the most suitable method for creating the surface in NX. As seen in Figure 23, From Poles smoothens out the shape compared with the other methods. Through Points and From Point Cloud look almost the same, but From Point Cloud tends to create folds in the surface where no ac-
tual point representation occurs. This is shown more distinctly when the degrees for polynomial fit are increased, see Figure 24.

![Figure 24: The surface created with From Point Cloud with a) the same settings as in Figure 23 and b) with increased degrees for polynomial fit to exaggerate the incorrect folds.](image)

The conclusion drawn from this comparison was that Trough Points was the most appropriate method to use. For better illustrations of the surfaces used in this test, see Appendix H.
Results and discussion

For both the 2D microstructure analyses and the 3D surface analyses the matter of interest was the behaviour of the residual vertical stresses in the topcoat of the TBC system after a simulated cooling from 1100 °C to 100 °C.

7.1 2D microstructure simulations

When comparing the results from the 2D microstructure analyses, a vertical stress inversion trend could be seen between the as-sprayed specimens and the specimens exposed to isothermal heat treatment (IHT), see Figure 25.

![Figure 25: Images of a specimen with HVOF sprayed bondcoat at a) as-sprayed condition and b) 200 hours of IHT, i.e. after TGO growth.](image)

The vertical stress inversion trend after TGO growth shown in Figure 25 complies with the statement made by Vaßen et al. [3].

As shown in the simulation made by Niklasson in Figure 5, the vertical stresses in the topcoat tend to form a bridge-like overlap between peaks. The 2D microstructure simulations indicate the same bridge formation, see Figure 26.
Comparison of stress behaviour in thermal barrier coatings using FE analyses

Figure 26: Illustrations of the vertical stresses in the TC from a sample with a HVOF sprayed bondcoat exposed to a) 100 hours of isothermal heat treatment (IHT), b) 200 hours of IHT and a sample with an APS sprayed bondcoat exposed to c) 100 hours of IHT and d) 200 hours of IHT.

The black rings in Figure 26 emphasise the bridges between peaks. In Figure 26d the stresses do not overlap as in Figure 26a-c, maybe because of the larger distance between peaks, but the initiating tendencies are present.

Because the 2D microstructure simulations appear to behave in the same manner as the theoretical models, it can be assumed that this approach may lead to simulations closer to the reality.

Shown in Figure 26, the TGO shape differs, considering both the minor irregularities and major wave shape for the two spraying methods, as well as specimens with different IHT. Also for the results within the same specimens, i.e. the same spraying method and IHT, differences in the TGO shapes are noticeable, see Figure 27.

Figure 27: Three images from the same specimen, i.e. the same spraying method and IHT, demonstrating the varying shape of the TGO.

These variations make the comparisons problematical, concerning bridge formations, stress levels and therefore the life. Consequently, no final conclusions about the difference in life between TBCs with bondcoats sprayed with HVOF and APS could be drawn. But it might be possible that an increase of the amount of tests could facilitate the comparisons.
7.2 3D surface simulations

For the 3D surface simulations, focus was laid on simulating a condition corresponding to 100 hours of IHT. The TGO thickness was estimated to 10 µm based on the SEM images taken for the 2D microstructure analyses (Appendix A). To verify the models, tests of one model from each sample without TGO was made, to investigate if the stress inversion phenomenon occurred, see Figure 28.

In Figure 28, similar stress inversion tendencies as in the 2D microstructure analyses and the theoretical models can be seen. This phenomenon appeared on the tests from sample B and C.

As well as for the 2D simulations, variations in the results between models from different domains and models within the same domain were evident. This made it difficult to make a comparison of the stress behaviour, see Figure 29.

No conclusions of if the stresses tended to be larger in the sample prepared with grit blasting (sample B) compared to the sample prepared with both grit blasting and
grinding (sample C) could be drawn, since in some cases they were larger for sample B and in some cases larger for sample C.

As seen in the example in Figure 29, the vertical stresses in the sample with the roughest surface (sample A) show the same tendencies as an as-sprayed model, even though it has a layer of TGO. One theory of what caused this behaviour is the way the models were made in NX. The different layers were extruded vertically, which resulted in a lower thickness of the TGO at the slopes, see Figure 30.

![Figure 30: Illustration of the varying TGO thickness when using extrude in NX with the input value set to 0.01 mm.](image)

According to Ahrens et al. [35], the stress inversion appears after a certain growth of the TGO in relation to the amplitude and wavelength of the surface. To investigate if this was an explanation to the unexpected behaviour of sample A, a test with an exaggerated thickness of 40 µm for the TGO of one model was made. This did not change the stress behaviour in the topcoat, see Figure 31.

![Figure 31: Illustrations of the vertical stresses in a model from domain A1 with a) as-sprayed condition, b) 10 µm of TGO and c) 40 µm of TGO.](image)

As Figure 31 shows, the stresses are slightly higher with 40 µm of TGO compared to 10 µm of TGO, but the behaviour is similar. No evident stress inversion are seen
when comparing these conditions with the same model in as-sprayed condition (Figure 31a).

By making a simple test where the topcoat of a 3D model from the domain A₁ was cut in four sections approximately 12.5 µm apart, a demonstration of how the profile varies depending on where the cut is taken was made, see Figure 32.

![Figure 32: Illustration of how the interface profile can differ by changing the position of the section. The distance between each of these sections is approximately 12.5 µm.](image)

Considering how much the profile varies by adjusting the cut only 12.5 µm, the exceeding amount of information available in a 3D model compared with a 2D model is obvious, since a 2D model solely represents one arbitrary section.

Since the 3D simulations cover more dimensions compared with the 2D simulations, i.e. the stresses acts in three dimensions, an investigation of how the stresses can vary when changing the angle of sight was done. A test with a 3D model from domain B₃ was made at four different angles, see Figure 33.

![Figure 33: Illustration of how the vertical stresses in the topcoat change when changing the view angle.](image)

As seen in Figure 33 the stresses, as well as the profile, looks different when looking at the model from different angles. This makes it hard to predict in which direction cracks will initiate and propagate.
8 Conclusions and future work

By continuously improving the way of simulating TBCs, an increased understanding of how different parameters affect the stress behaviour can be achieved. For example, by improving the simulations with different bondcoat roughnesses, an indication of the most suitable Sa-value of the bondcoat surface may be given. This can eventually lead to fewer spraying tests and improved coating properties by being able to predict the most preferable characteristics.

The main conclusion of this thesis project is that the 2D microstructure models confirm the theoretical models concerning the stress inversion and the stress overlap trend between peaks with TGO. This makes it reasonable to believe that the method of analysing microstructures as a complement to theoretical sinusoidal models is possible.

The 3D models from sample B and C confirm the theoretical models concerning the stress inversion, but the phenomenon with stress overlap between peaks were difficult to detect. An investigation would be very difficult due to the extensive amount of data in the 3D models when considering different view sections. When trying to compare the results within each method, it was shown that they differed a lot, and that comparisons turned out to be difficult.

To enable additional conclusions about the trends and stress behaviour present in both 2D and 3D simulations, more tests should be performed. For the 2D simulations, a suggested approach is to focus at either one state of IHT or one bondcoat spraying method at a time to get more accuracy.

To reach higher accuracy concerning the 3D models the mesh method applied needs to be revised, since irregularities occurred in some models, even though the same method was used for all models, see Figure 34.
It proved to be time consuming to find a method that was applicable to each domain due to differences in surface roughness and restrictions on the amount of nodes. The differences in the roughness resulted in compromises regarding the accuracy of the mesh applied and the size of the models. Therefore an improvement would be to avoid the issue of compromises by increasing the limits of e.g. number of nodes possible in the model. Then the mesh is able to express the surface more satisfactorily. To reduce simulation time, powerful computational performance and tools would be preferable.

The same Young’s modulus was used for both the 2D and 3D simulations. If the objective in future work includes investigation of the stress levels rather than stress behaviour, the Young’s modulus for the 3D simulations should be higher than for 2D simulations. This is because a crack in a 2D model has more influence on the Young’s modulus compared to a 3D model, where the crack will be enclosed by surrounding material, resulting in a stiffer behaviour.

An interesting test of how accurate the 3D models are could be to investigate a section of a 3D simulation, and then compare it with a 2D simulation of the same section. Would the result be the same? If not, how much does the 3D stress affect the result?

For the 2D simulations, a method of tracking the investigated specimens from as-sprayed to e.g. 200 hours IHT stage would make it possible to see the crack evolutions with the same TGO profile, which could result in more accurate predictions.

When comparing the created surfaces in NX with microstructure images, it is unavoidable not to notice that the generated surfaces measured with stripe projection technique are smoother than the bondcoat profile in the SEM images taken for this
thesis project, see Figure 35. In this aspect, the 2D simulations can be considered to have an advantage, since they can express more complex geometry, e.g. under-cuts.

![Figure 35: Illustration of how the profile of a bondcoat could look like in reality. The dashed line illustrates how this surface could be interpreted using stripe projection technique with a single camera.](image)

An improvement for the 3D simulations might be to scan the bondcoat at different triangulation angles, i.e. the angle between camera and projector [47], or increase the number of cameras. This would give a better interpretation of a complex surface structure. It would also be interesting if it was possible to scan the surface of a bondcoat after the topcoat has been applied. Then the deformation due to e.g. thermal conditions and collision of particles would be included.

To facilitate the continued work about these simulations to future users, manuals of the methods and the approach used has been documented thoroughly and handed to the company.
References


8. Nylén, P., Professor in production, head of research, PTC, interview [2011-11-29]

9. Gupta, M. K., PhD student in thermal spraying, PTC, interview [2011-11-29]


11. Niklasson, K., Assistant professor in mechanical engineering, University West, interview [2012-02-15]


Comparison of stress behaviour in thermal barrier coatings using FE analyses

31. Curry, N., PhD student in materials and manufacturing, PTC, interview [2012-02-10]
36. ANSYS 13.0 Help > Mechanical User’s Guide > Features > Contact > Contact Region Settings > Definition Settings
39. NX 7.5 Help Library > Design > Modeling > Methods in Feature Modeling > Inputting Points from a File > Inputting Points from a File – Rows of Points
40. NX 7.5 Help Library > Design > Modeling > Creating objects from the Insert Menu > Surface > Through Points and from Poles > Through Points and from Poles
46. NX 7.5 Help Library > Design > Modeling > Creating objects from the Insert Menu > Surface > From Point Cloud > From Point Cloud

47. Rosén, S., Manager, Toponova AB, e-mail [2012-03-02]
A. SEM images

Figure 36: HVOF - As-Sprayed.
Figure 37: HVOF - 100 hours of isothermal heat treatment.
Figure 38: HVOF - 200 hours of isothermal heat treatment.
Figure 39: APS - As-sprayed.
Figure 40: APS - 100 hours of heat treatment.
Figure 41: APS - 200 hours of heat treatment.
B. MATLAB algorithm

```matlab
1 % size - Declares the nr of points wanted.
2 % b - Step up for x-coordinates, starts with two to avoid the first zero
3 % value.
4 % points - Stores the nr of coordinates per row.
5 % Xlim - Stores the largest X-coordinate available.
6 % nrofY - Specifies the number of different Y-coordinates.
7 % dist - Stores the coordinate in the first column and second row, which is
8 % the distance between each coordinate.
9 % Xvalue - Contains the first X-coordinate present in the new file.
10 % Ycoordinate - Contains the first Y-coordinate present in the new file.
11 % coordinates - stores at which line the "for" - loop should start.
12
13 fid = fopen('path\<file_name>.dat'); % Reads data from
14 % data file, opens the file and stores it in 'fid'.
15 A = fscanf(fid,'%s\t\t\t\t\t\t\t\t[3,inf]'); % Goes through the file stored in
16 % 'fid', all three columns and all rows available and stores it in 'A'.
17 fclose(fid); % Closes the file.
18
19 ROWnr=1; % Declares 'ROWnr' and gives it the start value '1'.
20 m=dimread('path\<file_name>.dat'); % Reads numeric data
21 % file and stores in matrix 'm'.
22 ttotal=length(m); % Stores the largest number of "elements" along the
23 % largest dimension of the array 'm' into 'total'.
24
25 fid = fopen('path\<new_file_name>.dat','w'); % Creates a new file.
26
27 size=20;
28 b=2;
29 points=1;
30
31 while A(b,1)==0 % Counts the nr of coordinates per row in data file.
32 points=points+1;
33 b=b+1;
34 end
35 Xlim=A((b-1),1);
36
37 nrofY=ttotal(points);
38
39 y=(rand()*(nrofY-size))+1; % Generates a random number limited to
40 % (nrofY-size).
41
42 for row=1:y % Steps up "row" to be an integer.
43 row=row+1;
44 end
45
46 dist=A(2,1);
47
48 X=(rand()*Xlim); % Generates random x-coordinate limited to Xlim.
```

Figure 42: First half of the MATLAB algorithm.
Figure 43: Second half of the MATLAB algorithm.
C. Coordinate file format

<table>
<thead>
<tr>
<th>X-Coordinate</th>
<th>Y-Coordinate</th>
<th>Z-Coordinate</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.437600e+00</td>
<td>0.000000e+00</td>
<td>-2.118862e-004</td>
</tr>
<tr>
<td>2.442000e+00</td>
<td>0.000000e+00</td>
<td>-1.808642e-004</td>
</tr>
<tr>
<td>2.446100e+00</td>
<td>0.000000e+00</td>
<td>-1.934862e-004</td>
</tr>
<tr>
<td>2.450800e+00</td>
<td>0.000000e+00</td>
<td>-2.180330e-004</td>
</tr>
<tr>
<td>2.455200e+00</td>
<td>0.000000e+00</td>
<td>-1.940399e-004</td>
</tr>
<tr>
<td>2.459600e+00</td>
<td>0.000000e+00</td>
<td>-1.852541e-004</td>
</tr>
<tr>
<td>0.000000e+00</td>
<td>5.200000e+00</td>
<td>-5.619081e-005</td>
</tr>
<tr>
<td>4.400000e+00</td>
<td>5.200000e+00</td>
<td>-5.004494e-005</td>
</tr>
<tr>
<td>8.000000e+00</td>
<td>5.200000e+00</td>
<td>-1.199908e-005</td>
</tr>
<tr>
<td>1.320000e+02</td>
<td>5.200000e+00</td>
<td>4.594797e-005</td>
</tr>
<tr>
<td>1.760000e+02</td>
<td>5.200000e+00</td>
<td>1.084585e-004</td>
</tr>
<tr>
<td>2.200000e+02</td>
<td>5.200000e+00</td>
<td>1.027238e-004</td>
</tr>
<tr>
<td>2.640000e+02</td>
<td>5.200000e+00</td>
<td>5.004494e-005</td>
</tr>
<tr>
<td>3.080000e+02</td>
<td>5.200000e+00</td>
<td>-1.76697e-005</td>
</tr>
<tr>
<td>3.520000e+02</td>
<td>5.200000e+00</td>
<td>-6.818989e-005</td>
</tr>
</tbody>
</table>

Figure 44: The original format of the coordinate files, with the first column representing the X-coordinates, the second column the Y-coordinates and the third column the Z-coordinates.

<table>
<thead>
<tr>
<th>X-Coordinate</th>
<th>Y-Coordinate</th>
<th>Z-Coordinate</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.428800e+00</td>
<td>0.000000e+00</td>
<td>-7.755502e-005</td>
</tr>
<tr>
<td>2.433700e+00</td>
<td>0.000000e+00</td>
<td>-2.036917e-004</td>
</tr>
<tr>
<td>2.437600e+00</td>
<td>0.000000e+00</td>
<td>-2.118862e-004</td>
</tr>
<tr>
<td>2.442000e+00</td>
<td>0.000000e+00</td>
<td>-1.808642e-004</td>
</tr>
<tr>
<td>2.446400e+00</td>
<td>0.000000e+00</td>
<td>-1.934862e-004</td>
</tr>
<tr>
<td>2.450800e+00</td>
<td>0.000000e+00</td>
<td>-2.180330e-004</td>
</tr>
<tr>
<td>2.455200e+00</td>
<td>0.000000e+00</td>
<td>-1.940399e-004</td>
</tr>
<tr>
<td>2.459600e+00</td>
<td>0.000000e+00</td>
<td>-1.852541e-004</td>
</tr>
<tr>
<td>0.000000e+00</td>
<td>5.200000e+00</td>
<td>-5.619081e-005</td>
</tr>
<tr>
<td>4.400000e+00</td>
<td>5.200000e+00</td>
<td>-5.004494e-005</td>
</tr>
<tr>
<td>8.000000e+00</td>
<td>5.200000e+00</td>
<td>-1.199908e-005</td>
</tr>
<tr>
<td>1.320000e+02</td>
<td>5.200000e+00</td>
<td>4.594797e-005</td>
</tr>
<tr>
<td>1.760000e+02</td>
<td>5.200000e+00</td>
<td>1.084585e-004</td>
</tr>
<tr>
<td>2.200000e+02</td>
<td>5.200000e+00</td>
<td>1.027238e-004</td>
</tr>
<tr>
<td>2.640000e+02</td>
<td>5.200000e+00</td>
<td>5.004494e-005</td>
</tr>
<tr>
<td>3.080000e+02</td>
<td>5.200000e+00</td>
<td>-1.76697e-005</td>
</tr>
<tr>
<td>3.520000e+02</td>
<td>5.200000e+00</td>
<td>-6.818989e-005</td>
</tr>
</tbody>
</table>

Figure 45: The new format of the coordinate files. A line break and the row number have been inserted.
D. Point interpolation

Figure 46: The surface creation method *Through Points* in NX interpolates each specified point.
E. 2D and 3D FE models with rigid blocks

Figure 47: An example of a 2D model with the rigid block used in the 2D simulations in ANSYS.
Comparison of stress behaviour in thermal barrier coatings using FE analyses

Figure 48: An example of a 3D model with the rigid blocks used in the 3D simulations in ANSYS.
F. Effective Young’s modulus values

Table 7: Compilation of the calculated values from the Young’s modulus simulations.

<table>
<thead>
<tr>
<th></th>
<th>Effective Young’s modulus [MPa]</th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>As-sprayed</td>
<td>IHT 100 h</td>
<td>IHT 200 h</td>
<td></td>
</tr>
<tr>
<td></td>
<td>APS HVOF APS HVOF APS HVOF</td>
<td>APS HVOF APS HVOF</td>
<td>APS HVOF</td>
<td></td>
</tr>
<tr>
<td>Image 1</td>
<td>71525 111006 89610 73248</td>
<td>46632</td>
<td>81141</td>
<td></td>
</tr>
<tr>
<td>Image 2</td>
<td>94946 68290 84338 53142</td>
<td>57928</td>
<td>30480</td>
<td></td>
</tr>
<tr>
<td>Image 3</td>
<td>55613 88676 107751 58160</td>
<td>63134</td>
<td>46568</td>
<td></td>
</tr>
<tr>
<td>Image 4</td>
<td>91205 74116 78882 63468</td>
<td>53418</td>
<td>39109</td>
<td></td>
</tr>
<tr>
<td>Image 5</td>
<td>97595 99626 69685 64713</td>
<td>52034</td>
<td>31124</td>
<td></td>
</tr>
<tr>
<td>Average</td>
<td>82177 88343 86053 62546</td>
<td>54629</td>
<td>45684</td>
<td></td>
</tr>
<tr>
<td>Std. dev. (σ)</td>
<td>18037 17646 14193 7546</td>
<td>6232</td>
<td>20883</td>
<td></td>
</tr>
<tr>
<td>2σ</td>
<td>36075 35292 28385 15091</td>
<td>12465</td>
<td>41766</td>
<td></td>
</tr>
</tbody>
</table>
G. Specifications and images of bondcoat surfaces

Figure 49: Complete surface of domain A₁ (as-sprayed) created in NX using *Through Points*.

Table 8: Properties of the domains from sample A.

<table>
<thead>
<tr>
<th>ISO 25178</th>
<th>Domain A₁</th>
<th>Domain A₂</th>
<th>Domain A₃</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Arithmetic mean height</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$S_a$ [µm]</td>
<td>13.5</td>
<td>13</td>
<td>12.7</td>
</tr>
<tr>
<td><strong>Extreme peak height</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$S_{xp}$ [µm]</td>
<td>85.8</td>
<td>78.6</td>
<td>77.8</td>
</tr>
</tbody>
</table>
Comparison of stress behaviour in thermal barrier coatings using FE analyses

Figure 50: Complete surface of domain B₁ (grit blasted) created in NX using *Through Points*.

Table 9: Properties of the domains from sample B.

<table>
<thead>
<tr>
<th>ISO 25178</th>
<th>Domain B₁</th>
<th>Domain B₂</th>
<th>Domain B₃</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Arithmetic mean height</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>( S_a ) [(\mu m)]</td>
<td>8.87</td>
<td>8.62</td>
<td>7.45</td>
</tr>
<tr>
<td><strong>Extreme peak height</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>( S_{xp} ) [(\mu m)]</td>
<td>52.0</td>
<td>49.3</td>
<td>45.0</td>
</tr>
</tbody>
</table>
Comparison of stress behaviour in thermal barrier coatings using FE analyses

Figure 51: Complete surface of domain C₁ (grit blasted and grinded) created in NX using *Through Points.*

Table 10: Properties of the domains from sample C.

<table>
<thead>
<tr>
<th>ISO 25178</th>
<th>Domain C₁</th>
<th>Domain C₂</th>
<th>Domain C₃</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Arithmetic mean height</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$S_a$ [µm]</td>
<td>3.49</td>
<td>2.48</td>
<td>2.81</td>
</tr>
<tr>
<td><strong>Extreme peak height</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$S_{xp}$ [µm]</td>
<td>24.4</td>
<td>17.8</td>
<td>18.6</td>
</tr>
</tbody>
</table>
H. Comparison between different surface creation methods

Figure 52: Surface created with Through Points in NX.

Figure 53: Surface created with From Poles in NX.

Figure 54: Surface created with From Point Cloud in NX.